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Welcome to the thirteenth edition of my Final Cut Pro newsletter! 

The goal of this newsletter is to provide information helpful to the 
professional user of Final Cut Pro. This newsletter publishes around the 
middle of each month. Past issues are not archived, however, key articles 
are posted to my website for your future reference. Unless otherwise noted, 
all references are to Final Cut Pro HD, and are not guaranteed to work 
under any other version.

Also, please invite your friends to visit my web site -- www.larryjordan.biz. 
We are working to make it a great Final Cut resource!
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New on my Website

I've added the ability to do full-text searches of all the articles on my website -- 
there are over 62 articles as of today. To do a search, click the search link on my 
Home page, or at the top of the Articles page.

Plus, I've finally gotten my store working. You can now buy copies of my Final 
Cut book and brand-new DVD on DVD Studio Pro 3. Click here for the book -- 
click here for the DVD.

Hand's on Training for Final Cut Pro is getting raves!

Thank you to everyone who has written me about my book. Your reviews and 
comments have been outstanding and I'm delighted to read them. My publisher 
is also very pleased with sales so far. If you haven't purchased your copy of my 
book yet, here are two quick reviews to twist your arm.
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I have been following the book word for word, page by page. Even if I knew 
something I did it anyway. Not to my surprise, I have learned a great deal 
by taking the time to do this. If I would not have I would have missed a 
great deal. The process of reading and doing in the book and then seeing 
the video is just great. I like your writing style and the pictures. The video's 
really support the book well. It is like attending class. I enjoy the just plaIn 
talk and the humor. Humor is good when you are trying to really learn 
something. It puts things in perspective. (R.R. 2/8/05)

I just wanted to say that I received your book and dove into it straight 
away. Right off the bat I reviewed the QuickTime movies. I Immediately I 
picked up new shortcuts and more importantly how to use the vectorscope 
and waveform monitors to color correct my footage. Wow, what a big 
difference this made to my movies! I just wanted to say thank you for 
putting together such a great book. I have been using FCP for 18 months 
now as a hobbyist turning pro. I have found many similarities in my 
workflow with those which you describe. I still have a lot to learn and your 
book will help in this respect. (I.E. 2/10/05)

Click here to buy my book -- if you would like me to personally inscribe your 
copy, please make a note in the Special Comments field in the order form. 
Thanks!

[ Go to top. ]

Editorial: Be Careful When Upgrading

Last week, Apple released the latest version of OS X -- 10.3.8. This is just a note 
to remind you that if your editing system is working now, I strongly recommend 
you not upgrade. Even more important, don't upgrade immediately after an initial 
release! A good website to check for general problems is MacInTouch (www.
macintouch.com). 

All too often, clients upgrade only to discover that one of the components of their 
system is not compatible with the new software.

This will be ESPECIALLY true when OS X 10.4 (Tiger) ships. I fully expect that 
massive changes from a variety of software and hardware developers will be 
necessary to support this new operating system. Don't even THINK about 
upgrading for at least two months after the initial release, unless you have a 
system you can use for testing to make sure everything works before committing 
your production machines to the new version.

I'll keep you informed as I learn about problems. For right now, though, this is 
mostly a precautionary statement. As always, if you have specific questions, 
please email me.

[ Go to top. ]

Technique: 
Using Traveling Mattes to Reveal Portions of an Image

A few months ago, I wrote about how to use traveling mattes to hide a portion of 
an image. Recently, while editing an opening for a client, I needed to use a 
traveling matte to reveal portions of an image. This technique shows you how

A traveling matte is an effect that reveals, or hides, part of an image based upon 
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the contents of an underlying layer. The most common use of a traveling matte is 
to put moving video into letters of text. However, in this case, we will create 
something a little trickier -- a spotlight effect that travels across the screen along 
with the subject of the video. In this case our subject is, yup, you guessed it, a 
train.

Just to make this even more challenging, in addition to moving the spotlight 
across the frame, I'll also increase the size of the spotlight from small at the start 
to larger at the end.

Here's how it works:

1.  Edit the clip containing your subject to the Timeline

2.  If audio and video are linked, hold the Option key down and 
click on the video clip to select it

3.  Type Option -> Up arrow to move the video clip up one track



4.  From the Generator menu in the lower right corner of the 
Viewer, select Shape -> Circle

5.  Edit the shape onto track V1 of the Timeline and make it the 
same length as the clip on V2

6.  Select the clip on V2 and choose Modify -> Composite modes 
-> Travel matte-Luma. This reveals any part of the clip on V2 
which is over the white circle, and hides all parts of V2 that are 
over the black background.

7.  Click the Controls tab and set a Size keyframe at the beginning 
of the clip. Adjust the size to 15%.



8.  Click the Motion tab and set a Center keyframe at the beginning 
of the clip. Click the cross-hairs button, then click and drag the 
circle in the Canvas until it reveals the train engine in the 
distance.

9.  Move the Playhead in the Timeline until the engine is at it's 
ending position.

10.  Set a new Center keyframe in the Motion tab, click the cross-
hairs button, then click and drag the circle in the Canvas until 
the circle reveals the ending position of the engine.

11.  Finally, click the Controls tab and create a new Size keyframe at 
the current position of the Playhead. Change the size to 50%.



When you play the clip, the circle will track across the screen as the engine 
moves, growing larger as the engine grows larger.

As an advanced tip, if you want to make this really look like a spotlight:

●     Move the clips on V1 and v2 up one track to V2 and V3. Copy the clip on V3 
and paste it into V1

●     Turn on clip overlays at the bottom left of the Timeline

●     Drag the opacity of the clip on V1 to 40%.



This is an easy way to create the effect of a moving spotlight, or to reveal 
portions of an image based upon the shape of a white graphic below it, all using a 
traveling matte.

Larry Releases Training DVD on DVD Studio Pro 3

Larry just recently completed an instructional DVD for Lynda.com on Apple's DVD 
Studio Pro 3.

Learning Apple's DVD Studio Pro 3 is a movie-based tutorial intended 
for the beginning or intermediate DVD Studio Pro user who wants to 
gain a clearer understanding of how to create custom DVD content 
and delivery, as well as take advantage of some of the more 
sophisticated features of this software. This DVD includes over 6 
hours of tutorial movies and complete exercise files covering 
Compressor, A.Pack, DVD SP templates, creating overlay and motion 
menus, markers, stories, subtitles and scripts. Written and narrated 
by Larry Jordan.

http://www.lynda.com/


Here are two reader comments on the content:

I just wanted to drop a note to thank you for your excellent DVD Studio Pro 
lessons at Lynda.com. I've watched many of the video-related titles at 
Lynda and yours is, by far, the best of the bunch. (G.L. 2/2/05)

I am well into your [DVD Studio Pro 3] tutorial on Lynda.com. I have done 
several tutorials in their fine system but have found yours to be easily the 
best so far. I use DVDSP3 as a producer of industrial and promo DVD work 
in Adelaide, Australia. BTW, I love the humor and your droplet ideas are 
great. Thanks! (J.B. 1/13/05)

This DVD is available immediately in my store for $99, plus shipping and 
handling. Click here to buy it.

[ Go to top. ] 

Client Report #1: Final Cut Needs Video to Record Audio

I got a panic call from a client a week or so ago. They were trying to record audio 
from a DA-88 (a multi-track audio deck) into Final Cut and it would not record.

I'd recently installed a Blackmagic card into their system, so my first suspicion 
was that I'd done something wrong. However, after going back to the client's edit 
suite, everything seemed perfect -- except, it wouldn't record audio.

After a fast series of phone calls to a variety of folks the next day, I finally spoke 
with Mike Skibra, of Blackmagic Design, who let me in on this little secret: Final 
Cut needs video in order to record audio. Most of the time, when you are 
capturing from DV, this is no problem, because the DV deck is feeding audio, 
video and timecode all at the same time, even if all you want to capture is audio.

However, when you are capturing into a capture card using something other than 
FireWire, you must feed Final Cut a video signal, even if Final Cut is not recording 
the video. Final Cut uses the video signal as a reference. Without it, it won't 
record.

So, we hooked up a black burst generator to the video In of the card and Final 
Cut started recording. Flawlessly.

Sigh... There's always something new to learn.

[ Go to top. ]

Technique: Exporting Batch Lists (Part II)

Mike Krause, one of my students, wrote in with this technique for exporting 
batch lists from the Browser.

Other than to say "hi", I had a few thoughts on exporting a batch list, 
noted in the January newsletter. I'm currently doing something very 
similar for a project I'm working on and have a few tricks I'd like to 
pass along to the documentary editor.

I find when I export batch lists I don't usually need the info in every 
single column of the bin I'm working with. I have made a few custom 
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bin views where I've hidden all but three or four columns so when the 
list is exported, then imported into Excel, only the visible columns 
from your bin are available.

If you need one list to give to an assistant that only notes the clip 
name, ins and outs, you're set. Say the producer doesn't care about 
that but wants to know the clip names, good takes, comments, 
there's another view to use.

Also, when I have a long source tape with numerous shots, I will 
subclip all the shots I'm going to use into a new bin (or bins) and 
organize as needed. I rename them, add comments, etc. and export a 
batch list to work from instead of working from (for example) a 
cameraman's handwritten notes or the in-the-script's-margins notes 
from an on-set script supervisor.

Realistically, the time it saves the user is when working in Excel, so 
you don't have to sort and delete the info you don't need. 
Coincidentally, I've been exporting various tape and project logs like 
mad lately and have found I can do the same sorting in FCP HD in half 
the time as well as better organize my projects at the same time. And 
a well organized project frees one's mind up for editing...

Larry replies: I have two comments. First, this technique works even if you don't 
use subclips. For me, I prefer to capture shorter clips, rather than long ones.

Second, using Excel as part of your capturing technique works both ways. When I 
was heavily into production a couple of years ago, I found I could log tapes faster 
in Excel than using Final Cut. So I created an Excel template that I used for all 
my logging. I then saved that template as a tab-delimited text file. Finally, I 
imported that text file as a Batch List (File -> Import -> Batch list) and all 
clips came in ready to capture. 

If you are interested in using my template, click here to download a copy. You 
will need Excel in order to use it. Instructions are included in the worksheet.

[ Go to top. ]

Technique: Importing Layered PhotoShop files from PC

This tip comes from Jim Tapley, who writes:

I have run several tests, and have proven what a member of my 
Apple / FCP discussion group told me. Final Cut Pro HD has an issue 
with files originated in Photoshop on a PC. I have saved and imported 
files several ways, and every Photoshop file originated on the PC will 
only import as a flattened image. I tried it two different ways: 1] 
using my LaCie portable hard drive with the FAT32 file system that 
both Macs and PCs recognize, and made sure I was pulling files 
straight off the hard drive, not out of a folder on the hard drive, and 
2] by burning a CD with the files on it. I couldn't get FCP to open any 
Photoshop file, originated on the PC, as a layered sequence.

I downloaded a trial copy of Photoshop for Mac, and opened the 
Photoshop files created on the PC into Photoshop on the Mac, then 
saved them again. (Photoshop didn't seem to care that the portable 
drive utilized the FAT32 file system.) Again and again, Photoshop files 
opened into and saved by Photoshop for Mac imported into FCP HD 
without a problem.

http://www.larryjordan.biz/goodies/log_template.xls


Looks like I'll be purchasing another version of Photoshop!

Larry replies: I don't own a PC, so I don't have a way of testing this. However, 
for you bi-computer users, you might want to be aware of this and let me know if 
your results are similar.

[ Go to top. ]

Classroom Note: 
Correcting Pixel Aspect Ratios in PhotoShop CS

Last week, during one of my Final Cut classes, Ryan pointed out a new feature of 
PhotoShop CS that I didn't know.

One of the big problems in designing graphics on the computer for use in video is 
that the computer uses square pixels, while video uses rectangular ones. This 
causes all kinds of difficulties. 

The latest version of PhotoShop CS has a new menu option that changes the 
display from one pixel aspect ratio to another. Best of all, this only affects the 
DISPLAY of the image, not the actual size of the image. This allows you to design 
images that have the correct geometry on your computer, without having the 
deal with creating images at different image sizes.

As I hadn't upgraded to CS yet, I didn't know about this option. Now, I do.

[ Go to top. ]

Technique: Scrolling Vertically on the Timeline

Mike Eastman recently wrote:



I have two monitors and run my time line across both. I have trouble 
with the scrolling vertically. Because [I have to move the mouse all 
the] way over to the right of the right monitor. What about an article 
on short cuts and in and outs of the scrolling vertically in the timeline.

Larry replies: There are a number of ways to scroll vertically on the Timeline; 
more than you might expect.

1.  If you have a mouse with a scroll wheel, place the mouse in the 
middle of the Timeline and roll the wheel. The Timeline scrolls 
vertically, depending upon whether your mouse is in the video 
or audio section.

2.  Drag the blue thumb-wheel at the right side of the Timeline
3.  Click the up and down arrows at the right side of the Timeline

4.  Grab the heavy, gray bar in the middle of the Timeline and drag 
it up or down to reveal more, or less, of either video or audio 
tracks. (This isn't, technically, scrolling, but it does allow you to 
see more tracks.)

5.  Type "H" to select the Hand tool. Click and drag in the Timeline. 
If you drag vertically, you move vertically. If you drag 
horizontally, you move horizontally.

 



By the way, if you have a scroll-wheel mouse, put the cursor at the top of the 
Timeline, where the timecode numbers are, and you can scroll the Playhead by 
rolling the wheel.

Also, Mike, I've seen problems in the past where the Timeline spans two 
monitors. I recommend keeping the Timeline, Canvas and Viewer on one monitor 
and use the second monitor for your Browser, Scopes, and other windows.

[ Go to top. ]

Product Note: More on Flip4Mac

Last month, I mentioned a new product called "Flip4Mac," (www.flip4mac.com)

Well, after I published last month's issue, I discovered I had totally overlooked 
the Options button when selecting Windows Media on export, so I wanted to give 
you some more information about it.

Filp4Mac is a plug-in that allows you to export and compress Windows Media files 
directly from Final Cut. Let's take a closer look at its controls. 

 

After installing this plug-in, when you export a sequence from Final Cut (File -> 
Export -> QuickTime Conversion), select Windows Media from the output 
options and click the Options button. This shows four tabs -- three for output 
options and one for registration.

The Video tab allows you to select how you want to export your file - WMV 9 
Standard or WMV 9 Advanced. If you want your file to play on both PC's and 
Mac's, select Standard. If you only want your file to play on PC's, select 
Advanced.

http://www.flip4mac.com/


If you can afford the time, you are always better off encoding using VBR 
(Variable Bit Rate). You will get better quality and smaller file sizes, but it takes 
about twice as long to encode a file).

If you are working with DV (or Betacam) NTSC video, the input frame will, most 
often, be interlaced. If it is interlaced, both DV and Betacam use Lower Field 
First. (I am not sure of the field dominance settings for PAL video.)

Output frame size has a whole lot of options for NTSC and PAL, 4:3 and 16:9. As 
a rule, file size (and download time) increase significantly as frame size increases.



 

Here are the settings I used for encoding my test video.

The Audio tab, also, provides a number of options, as you can see here. 
Generally, if you are using just narration, you should reduce your sample rate to 
22k or, even, 11k. Also, stereo files take up double the space of mono files, so 
keep that in mind as well.



Finally, here's the Content tab, where you can add descriptions of the content of 
your sequence.

Here's the finished result -- it's the sequence I created earlier showing how to 
use Travel Mattes. 

As a note, I couldn't double-click on the file to open it. Instead, I opened it within 
the Windows Media Player. (After taking this screen shot, I selected the file on 
my Desktop, chose File -> Get Info, and set the "Open With..." setting to 
Windows Media Player. After that, double-clicking opened the file as you would 
expect.

In a recent email with Barbara, over at Flip4Mac, I was told that they were 
working on an import module that would allow FCP to import Windows Media 
files. The module is currently scheduled for a March release.

Update - Feb. 14 (late at night)

Shortly after going to press, Craig Seeman wrote in with more info on 
compressing using Flip4Mac:

I'm a subscriber to your excellent news letter. I also do consulting 
work for Telestream Flip4Mac as a product tester and trouble shoot 
issues for some users.

 



Just thought I'd add some things you mention in your news letter.

In the Windows world Constant bit rate is best used for streaming (as 
from a streaming server) and of course 2 pass CBR is better than 1 
Pass CBR.

VBR is best for "progressive download." Of course 2 pass VBR is 
better than 1 pass VBR and takes longer as you mention. Note there 
are other differences between 1 pass and 2 pass VBR.

With 1 pass VBR the quality slider is ghosted. You're simply targeting 
the Quality and encoder makes decisions as to how it hits that quality 
mark. Hence, a fast action video will likely have a higher data rate 
than a talking head video set to the same quality setting.

2 pass VBR targets a Bit Rate over time (an average). The quality 
slider "tells" the encoder that, based on what's happening at the 
moment, whether it should drop frames in order to preserve a level of 
sharpness (colloquially speaking). Personally I don't ever want 
dropped frames. I think most people find that more disconcerting than 
a slightly softer image during an "action" scene. I simply leave quality 
set to 0. If the image is too soft I'll simply up the data rate target. Do 
a test on a 2 pass VBR. Do one encode with Q set to 0, another set to 
100. Tell me what you see. You may not see any difference since 
most of the time the encoder will not have to make that aesthetic 
choice.

I also noticed you used a frame rate of 15fps. These days I always 
use 29.97 for NTSC and 25 for PAL. Going to 15fps doesn't cut the file 
size in half although it will cut the size a bit. I'd rather have the 
smooth motion although 15fps is fine for talking heads. Encoders base 
there decisions, in large part, in the differences from to frame. If you 
have fast action video (camera moves, heavy effects, dissolves, car 
chases), at 15fps you're actually increasing the differences from frame 
to frame so the encoder has a harder time finding/tossing 
redundancy. I believe going to 15fps may help if someone is using an 
older computer to view since it can make it easier on the decode side 
of things.

Flip4Mac not only works in FCP, it works in QuickTime Pro (that way 
you don't have to tie up FCP), iMovie and Cleaner (and Sorenson 
Squeeze 4.1 which was announced at MacWorld and should be out 
soon).

You might have noticed the HD frame sizes 1280x720 and 
1920x1080. Flip4Mac can output WMV HD. Those files can be played 
on a fast PC (not a Mac) out to a HD TV set. There's even a very scant 
few DVD players that can decode WMV HD. Nope, it's not BluRay of 
DVDHD but it's an option for those who want to display full screen HD.

[ Go to top. ]

Client Report #2: 
What does the NS light on DVCAM decks mean

About two weeks ago, I got a call from another client who recently installed a 
Final Cut Pro editing system. They were shooting on MiniDV gear, editing in Final 
Cut and outputting to a Sony DSR-25 DV/DVCAM deck.



These tapes would then be cablecast from a DSR-20 deck, located in another 
room.

When they took tapes recorded from the DSR-25 deck and played them on the 
DSR-20, a small "NS" light illuminated on the front panel of the deck. While the 
tape playback looked OK, they were worried and gave me a call.

I encountered this several years ago, on another editing system. But I managed 
to solve it purely by accident - and I couldn't remember the solution.

First, I reassured them that "NS" did not mean "no sync." Their tape would play 
back fine. Then, I hit the phones to find out the complete answer.

It came from Sony's Broadcast Tech Support Center on the East Coast. (And, by 
the way, I was VERY impressed with their phone support rep.)

"NS" means "non-standard," and it refers to the audio signal.

When Final Cut captures audio via FireWire, it stores and edits it in the format it 
was recorded on the video tape. MiniDV uses an "unlocked" audio format which, 
when you are working in an non-linear editing environment like Final Cut, is 
perfectly OK. 

DVCAM, on the other hand, uses a "locked" audio format. The difference is that 
when you are editing from one tape deck to another in a linear environment, 
locked audio can be insert edited (assuming this function is supported by the 
deck), while unlocked audio can only be assemble edited -- or so it was explained 
to me.

So, when FCP captures audio from a DV tape, it captures it in an unlocked state. 
Again, for editing inside Final Cut, this is NOT a problem. The issue arises on 
output.

Almost all Sony decks provide a switch so you can choose whether to record in 
MiniDV or DVCAM mode. If you capture from MiniDV, you should output with the 
deck set to MiniDV format. If you capture from DVCAM, you should output with 
the deck set to DVCAM. The image and audio quality will be the same in either 
case.

The NS light appears, however, when you capture from MiniDV, but output to 
DVCAM. DVCAM is expecting a locked audio signal. However, Final Cut captured 
an unlocked signal. So, the NS light appears to tell you that your audio is non-
standard.

While this is not a problem for playback, it might cause a problem if you decide 
to recapture from that tape.

For this reason, Sony recommends outputting in the same mode you first 
recorded your masters.

When I relayed this information to my client, they switched their decks from 
DVCAM to MiniDV and the NS light went out.

[ Go to top. ]

Update: Using Media Manager for On-lining

Rick Lavon wrote:



I was mainly an Avid editor until a few months ago when I talked my 
bosses into switching to a FCP station after getting frustrated with 
Avid business & sales practices. I had used FCP at home and for small 
projects. Now I am using it on a daily basis for full-blown shows for 
broadcast and news features and loving it.

My question is about using Media Manager (MM) as laid out in your 
article on your website. I am trying to do a hi-res version of an offline 
project. I followed your guidelines and still came up with issues. 
Mainly, I create a new project in MM using your settings. I get a bin 
full of offline master clips. I try and capture them. I get a message 
saying there are duplicate files with the same name. I skip them, 
even though it seems like it is listing every clip as having a duplicate. 
I even delete the offline sequence. Same thing. 

Anyway, I try and digitize from one tape, 5 clips. They all show up 
with the same duplicate file box message. I capture them anyway. Of 
the 5 clips, all show up in my sequence as captured. But in my bin on 
2 of the 5 show up as redigitized. Three still are "offline" even thought 
they are in the sequence. Is this weird or what? Do you have any 
suggestions?

As an alternative, could you use a trick I did from my Avid days, 
where if you were clever and organized enough, all your off-line files 
reside on one drive, You then unmount it from the desktop, restart 
FCP, they show up as offline, and then you recapture at a higher res 
to another drive. You then trash the files on the other drive when you 
remount it.

Larry replies: Rick, the reason you are having problems is due to those 
"duplicate" files. They aren't actually duplicates. (For those who want a refresher, 
here's the link to the original article.) When you unlink a sequence of clips, you 
are, essentially, disconnecting the audio and video. This means that both the 
audio and video components of a clip will be captured separately. However, both 
the audio and video clips have the same name.

When you capture, the name given to the media file stored on your hard disk is 
the same as the clip name. However, since both the audio and video clips have 
the same name, Final Cut puts up an alert saying two clips have the same name 
and gives you the chance to rename them. (Now, I grant you, this dialog is very 
poorly worded, and it's taken me the better part of a year to figure this out.)

If you DON'T rename these duplicates, then the second clip you capture 
automatically erases the first because two files in the same folder can't have the 
same name. 

It is not intuitive, but to solve this problem, what I do is add the letter "a" to the 
end of each duplicate file name. Everything captures fine and all my clips appear, 
on-line, in the Timeline. (There's nothing magic to the letter "a," it's just fast for 
me to type.) 

As for unmounting a drive, this solution will work as long as you have more than 
one drive to store media. For those who are using a RAID as their central 
storage, this trick won't work. You are better off following the tips in my on-lining 
article.

[ Go to top. ]
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Tip - Recreating Master Clips

This tip came from a question Dilesh Korya sent in:

After you have created a new project and saved it, the clips in 
Timeline are not linked to clips in the [Browser]. Consequently you 
cannot 'Modify -> Reveal Master Clip' (shift-f). 

[To solve this] go to 'Tools', and click on 'create master clips'. FCP will 
ask a few questions, just answer yes/or continue. This will look at all 
the clips in the timeline, and relink them to the bin. For any clips that 
it finds that don't have a master clip (slugs, etc.) FCP will the create a 
master clip in a new folder called 'Master Clips'. After it has done all 
the work, I just deleted this folder/bin. I understand that this is a 
pretty unstable way to re-link the clips, but I cannot find any other 
solution. Do you have any answers?

Larry replies: Actually, Dilesh, this isn't an unstable procedure, but your 
description misses a key step.

When you create a new project from scratch, the first time a clip appears in the 
Browser it is flagged by Final Cut as a "Master Clip." Each time you edit that clip 
to the Timeline you create "Affiliates" of that Master clip. So far, everything is 
normal.

Affiliate clips in the Timeline are related to Master clips in the Browser on the 
basis of four criteria:

1.  File name
2.  Reel number
3.  Time code
4.  Auxiliary time code

However, when you make a copy of that sequence or project, all the clips in the 
new sequence, by definition, are not linked to the clips in the Browser. Therefore, 
using the command Modify -> Reveal Master Clip won't work.

In fact, there are three ways to break the relationship between a master clip and 
it's affiliates:

1.  Deleting a clip from the Browser that also appears in the 
Timeline. The Timeline clip will remain, but will become 
independent, rather than affiliated.

2.  Copying a sequence into another project.
3.  Opening a clip in Final Cut using the Open command, then 

editing it to the Timeline, rather than importing it into the 
Browser first.

To find the way to get everything linked back together, I turned to the Final Cut 
manual, page 283, and read the following steps to using the Tools -> Create 
Master Clips command:

1.  Do one of the following to define the scope of the Create Master 
Clips operation: 

* To create master clips corresponding to every clip in your 
project, make sure nothing is selected in the Browser or the 
Timeline

* If you want to limit the creation of master clips to a specific 
group of clips or sequences, select them



2.  Choose Tools>Create Master Clips. 

Afterwards, every independent clip in your project becomes associated with a 
master clip in one of two ways:

●     If a master clip linked to the same media already exists: 
Independent clips that are linked to the same source media on 
disk become affiliates of these preexisting master clips. 

●     If no preexisting master clips matches the independent clips in 
your project: New master clips are created for each independent 
clip that doesn’t match a preexisting master clip. All newly 
created master clips are placed in a new folder named “Master 
clips for [project name].” 

[ Go to top. ]

Article: Color Compression in DV, or, 
What Does 4:1:1 and 4:2:2 Really Mean?

Recently, I've received a lot of questions asking about color compression in DV. 
Rather than rehash everything here, I want to point out an article on my website 
that may be helpful to you in understanding this issue.

If you plan on using DV for chroma-key, or other fancy color work, please read 
this article:

http://www.larryjordan.biz/articles/lj_compress.html

Here's the commercial that supports this newsletter.

I provide system design, consulting, editing, training and support for Final 
Cut Pro, DVD Studio Pro and Motion.

You can review my support and training services here.

If you need training, help or advice with Final Cut Pro, DVD Studio Pro, or 
Motion, I'd appreciate it if you would give me a call, (818) 879-5105, or 
send me an email -- larry@larryjordan.biz -- worldwide.

My client list speaks for itself.

Your support of my services keeps this newsletter free.

Thanks.

Oh, and please buy my book - or DVD! Thanks.

[ Go to top. ]

Reader Mail

HDV

Tom Wolsky writes:

http://www.larryjordan.biz/articles/lj_compress.html
http://www.larryjordan.biz/about/services.html
mailto:larry@larryjordan.biz?Subject=Help,%20please!
http://www.larryjordan.biz/about/clients.html
http://www.larryjordan.biz/cgi-bin/ecommerce/ac/agora.cgi?xm=on&product=Books
http://www.larryjordan.biz/cgi-bin/ecommerce/ac/agora.cgi?xm=on&product=DVDs


[In your MacWorld report, you wrote:] "Apple announced that the 
latest a/v codec (H.264) is now shipping in iMovie and Final Cut 
Express HD. A couple of months ago, Apple said that H.264 will be 
supported in a future version of FCP."

Are you sure about that? I don't see it in iM5 yet. My recollection of 
the keynote was that H.264 was in QT7. The Apple Intermediary 
Codec, which is used to transcode HDV material, is in iM5 and FCE3.

Larry replies: In the initial version of last month's newsletter, I announced that 
Apple had included H.264 in iMovie and Final Cut Express. This was a mistake, for 
which I apologize. What Apple announced and included was the HDV codec. 
(Sigh... I hate making mistakes.) 

When I got Tom's note, I immediately corrected the newsletter. However, about 
half of all newsletter readers read the issue within 24 hours of release, so I'm 
including this update in case you missed it.

Apple announced that the latest a/v codec (HDV) is now shipping in iMovie and 
Final Cut Express HD. A couple of months ago, Apple said that HDV will be 
supported in a future version of FCP. This new codec, Apple said, allows us to 
create one version of our program that can be played on a multitude of different 
devices, from cell phones to broadcast television, without recoding.

As HDV is, essentially, a version of MPEG-2, what Apple is doing is transcoding 
HDV from a GOP-based MPEG stream into a frame-stream, like DV, using the 
Apple Intermediate codec.

- - -

By the way, Philip Hodgetts just published a fantastic summary of the new HDV 
High Definition format over in the Pro Apps Hub: "HDV - Is it something or is it 
nothing?" 

With so much hype surrounding this new, highly compressed format, it's hard to 
find definitive answers to how they put High Definition onto a miniDV tape and 
what it means for production and post production. Phil covers the technology 
involved, how it looks in practice, how it can be edited, distribution issues and 
how it is likley to fit into, and change, production and post production, this is the 
definitive HDV summary.

"HDV - Is it something or is it nothing" is available through the Pro Apps Hub - 
this is free software that helps you make sense of Internet resources. You can 
download the Pro Apps Hub free from http://proapps-hub.com/download.html.

By the way, Phil recently started a blog a couple of weeks ago, called, "The 
Present and Future of Post-Production business and technology" (modest little 
title) where he shares his more 'out there' thinking. 

You can find it at: http://www.intelligentassistance.com/blog. I have always 
enjoyed Phil's musings, so you might want to check into this, as well.

Ben Bryant writes:

I'm a cameraman/director/editor with 25+ years in the business, 15 
as an AD/Producer and another 12 or so as those other three. I came 
to FCP 1.0 from analog tape editing and I love it. However, analogous 
to the way that I use a car, I can drive it pretty well but really don't 

http://proapps-hub.com/download.html
http://www.intelligentassistance.com/blog


comprehend what's under the hood. Your articles are very helpful in 
that regard because, like it or not, if one is using FCP one must have 
at least minimal geekish skills.

I'm about to begin production on another documentary and would like 
to shoot and edit it in some form of HiDef. The new Sony HDV camera 
is being highly touted and is affordable. (I'll need at least three 
cameras for this project.) Ken Stone, my friend and guru, tells me 
that FCP does not as yet handle this format. Is there any light you can 
shed on this question?

Larry replies: Ben, at the moment, FCP does not natively support the HDV 
format, though Apple has announced that it will support it "in a future version." 
My guess is that Apple will announce a new version of FCP at NAB in mid-April. 
It's my hope that support for this codec will be announced at the same time. 
HOWEVER, this is just a guess, I am not privy to any of Apple's forthcoming 
product plans.

However, Lumiere has released a plug-in for HDV on FCP that is drawing glowing 
comments. You can read more about it here: http://lumierehd.com.

And, Frederic Haubrich, of Lumiere, has written an excellent workflow 
description using HDV in combination with iMovie and FCP. I asked him where I 
could find the best description of this technique and he sent me this link:

http://www.dvinfo.net/conf/showthread.php?s=&threadid=38145

If HDV is something you are interested in, these links will help. 

DVX-100

Last month's article on capturing from the Panasonic DVX-100 has created an 
unbelievable reader response -- it is by far the most popular article on my 
website this month.

Niklas Lundin wrote in with a follow-up to the DVX article:

I found an article at dvxuser that´s very interesting [for comparing 
three popular cameras]: 

http://www.dvxuser.com/articles/shoot3/

Larry replies: If you own a DVX-100 camera, the forums on this site are great -- 
www.dvxuser.com

That D'Oh Moment

Andy Field writes:

I’ve used Final Cut Pro to cut spots for ABC News, Discovery, PBS and 
corporate clients as big as McDonalds and Nextel – Every time I think 
I knew it all – you come up with some great tips.

As for the “Doh” moment – the Paste Attributes (content tip) was one 
of them. Can’t tell you how many times I built some exotic twelve 
layer effect and then want to replace the video – and went through 

http://lumierehd.com/
http://www.dvinfo.net/conf/showthread.php?s=&threadid=38145
http://www.dvxuser.com/articles/shoot3/
http://www.dvxuser.com/


the:

●     Copy attributes
●     Replace content with in and out points
●     Re-paste attributes to get the effect back the way I want it.

When the Replace content button was staring me in the face!

DOH!

Even simple things like holding the option key while putting and 
moving a point for a garbage matte – maybe this aging mind isn’t 
sharp enough to see these “right in front of your face” short cuts.

Bottom Line – your news letter is great – and as much as I know 
about Final Cut (I’ve used since it was version one) - I’ll go out and 
buy your book just to keep you in business and the tips coming!

Larry replies: Don't worry about that "D'Oh" moment. I teach Final Cut, and in 
every class someone discovers something I didn't know. That's part of what 
makes using Final Cut so cool (well, OK, frustrating because there's so much to 
learn, but still cool).

[ Go to top. ]

The Future of FCP

Richard Randolph writes:

[It] looks like you and I agree on what might happen with FCP. Maybe 
it's a wish but, [Core] video and [Core] audio units show so much 
promise I hope the FCP team uses them. It continues to make sense 
that FCPHD 5 will need Tiger to run. I know this will cause some 
editors problems but it is time for them to switch.

Larry replies: Richard, I suspect that FCP will take full advantage of Core Video 
and Core Audio -- as will Motion. The benefits of moving video and audio 
operations to the operating system are MUCH faster performance and less code 
to develop and maintain in the application; plus, consistency across multiple 
applications.

- - -

Bart Weiss writes:

I think the next FCP will have integration of Logic not iTunes. Logic is 
the next step from soundtrack. While GarageBand got major upgrades 
at Macworld, Logic will be the way to do audio post and composing in 
one step. The filters and the instruments are really great in Logic. 
When [you are] working [with] filters you get to see what is 
happening with the sound [it's]like working color correction with 
wheels instead of lines. Just my 2 cents

Larry replies: Bart, interesting comments but I disagree. Logic is a great tool for 
creating music, but it is not a great tool for mixing. It also requires you to be a 
musician to get the most out of the product. In most cases, video editors are not 
musicians. There is still a strong need for tools like Bias' Deck or ProTools to mix 
our productions.



- - -

Mikal Lawton writes:

Love your newsletter, very informative and entertaining, your 
personality really shows through your writing. It's a darn shame Apple 
is dropping Soundtrack, I love the interface and interchangeability 
with the mother ship FCP. I guess Apple is dropping the product 
because the stand alone version of Soundtrack has been having poor 
sales. 

So, why doesn't Apple just drop the stand alone version and keep it 
bundled with FCP instead? Maybe Apple is keeping Soundtrack under 
raps because they are totally rebuilding it from the ground up. The 
new version of soundtrack will, therefore, incorporate features from 
Garageband, and Logic. Or, it could be an entirely new scoring 
program!! Who knows we will just have to wait and see.

Larry replies: We shall see, indeed. But my bets are on SoundTrack going away.

[ Go to top. ]

Monitoring the Situation

Roy Close writes:

As I have come to expect this is another great newsletter… thanks a 
million - so very helpful!

I was particularly interested in the article Technique: Connect a Video 
Monitor to Your Computer, as I have been using my camera as a go-
between my G5 and TV set alongside.

Your instructions partially produced the desired result and I have a 
clone of the blue Apple "swish" desktop on my TV, but FCP doesn't 
show! My mouse cursor floats across to the TV but none of the FCP 
(or any other application I may have open for that matter).

[pause....new email]

Sorry - I was too hasty in writing you before I "fiddled" enough! I now 
realize that the TV is only an EXTENSION of the computer monitor, 
not a CLONE of it! I dragged the Canvas window over to the TV - 
Ahhhh! NOW I understand!

This, though, is not what I hoped for. I wanted the TV to show me 
what I was creating, as "what the end-viewer will see on his/her TV", 
not simply an extension of my G5! I sure need to read and "fiddle" 
more carefully! 

Larry replies: The video monitor acts as an extension of your computer desktop, 
rather than as a video monitor. So, to see something in the monitor, you need to 
drag the window over to it.

For me, connecting your monitor to the computer is a workaround -- it's better to 
connect the monitor to a deck. But, if you don't have a deck, this works.

[ Go to top. ]



Great DVD Site

Ben Balser writes:

I'm writing in response to Lindsay Cornick's request [in last month's 
issue] for good DVD web sites. I have found what I believe to be "the" 
DVD web site and discussion board: Bruce Nazarian's site: www.
recipe4dvd.com.

I did a DVD authoring workshop with Bruce at the 2004 WEVA Expo 
that was awesome. I also got to spend some time chatting with him at 
his booth in the exhibitors area. He is about the most knowledgeable 
person on DVD that I've ever met. His experience is unsurpassed. Not 
to mention he's a hell of a nice guy, too. I recommend his book and 
tutorials highly. I'm doing one to learn DVD Scripting now that is 
teaching me so much so easily.

Although his products lean towards Apple's products, his discussion 
board covers all the authoring applications. He concentrates on the 
DVD Specs more than any single application. I've learned a great deal 
from the discussion board on Yahoo, also (which is linked from the 
web site).

Larry replies: While I've only met Bruce once, and that briefly, I hold his DVD 
knowledge in very high regard. He's a good source to turn to when you need help.

Video is Like Stills That Move

Robert Capra writes:

I've been reading your newsletter for a while and I wanted to take a 
moment to say thank you for the fantastic work. I've learned a lot and 
much of what I've picked up just didn't seem to be available from the 
3 or 4 FCP books I've waded through. I'm a professional (still) 
photographer with 25 years behind 35mm through 4x5 cameras. 

A couple of times over those years I assisted a friend who was a 
camera operator/director of small budget movie projects. I always 
dreamed of how great it would be to transform my ideas to moving 
film, but the awareness of the cost and complexities involved kept me 
away. 

It's an amazing time to be learning this craft, and although the costs 
are certainly a fraction of what they used to be, the complexity level 
seems to have remained somewhat constant. Thats why I'm so 
grateful to people like you who put in what must be an incredible 
number of hours (to write and produce the newsletter) to help all of 
us aspiring film-maker/FCP editors. Again, thanks Larry. 

Larry replies: Thanks for the kind words. Shooting video is just like shooting 
stills, except, um, everything is moving. Which can drive you nuts, I guess. 
Anyway, the cost of an inexpensive DV camera, while not up to the specs of a 
4x5 Hassleblad, is still cheap enough to give you something to play with as you 
learn, without breaking the bank. And you don't need to use a darkroom to 
develop your pictures.

http://www.recipe4dvd.com/
http://www.recipe4dvd.com/


[ Go to top. ]

HD is the Future

Issa Edah-Tally writes:

[I attended my first MacWorld keynote this year and] was absolutely 
blown away with the whole presentation but most of all the people I 
met at the exhibition. 

Steve Jobs announced this year to be the year for HD and this was 
further endorsed by his guest speaker the President of Sony who also 
took to the stage to promote HD and Sony HD Camcorders. As you 
are aware Apple have built in support for HD into iMovie just as 
FCPHD already has. Do you think we will see a big shift by consumers 
in 2005 to the HD format. I just invested in a Canon XL2 (last 
October) and am using it to making short documentaries. I am really 
pleased with the camera and get fantastic results but I am now 
beginning to think I should have waited a little longer and invest in 
HD camcorder and that SD video will eventually die. I'd be interested 
to know what other reader think about this ?

Larry replies: HD is definitely the format of the future, but before you get carried 
away, take a look around at what format TV you and your friends are watching. 
There are eighty-gazillion SD TVs in America alone; (I know, I've counted every 
one of them). 

So, while HD is coming, SD is not going away anytime soon. Your camera 
investment is safe, but I'm willing to bet the next camera you get will be HD.

[ Go to top. ]

The Out's Like the In, Only Different

Laurence Starkman writes:

I am new to FCP4, having recently moved over from the now defunct 
EditDV/Cinestream.  The transition has been fairly easy although I can 
find many faults and complaints about FCP.  By far my biggest 
complaint though is the fact that the FCP playhead is one frame long, 
as opposed to zero frames long.  In other words, if you mark an in 
point, then move the playhead forward exactly one second, and then 
mark an outpoint, you have just marked a shot that is ONE SECOND 
AND ONE FRAME LONG!  I have seen the other way (in EditDV), and it 
works much better.  I won’t bore you with a list of advantages, but I 
have taken an informal poll of my FCP friends and they all seem to 
agree that in practical terms it would be much better.  The only 
reason I can see FCP works this way is because Avid does.  What do 
you think?  Any possible chance this could be changed?

I know complaining about a long established convention is an exercise 
in futility, but here is more fuel for the fire.  

I'm sure you'll agree that the real function of a frame (be it film or 
video) is how it appears IN TIME.  That is, how it appears going by at 
its frame rate.  I often mark my “ins” and “outs” on the fly.  That is, 
as the shot is playing in real time.  When I do this in FCP, I am 



actually given an extra frame.  Examined more closely, when I hit the 
mark out button, the out is marked at the location of the playhead.  
But FCP assumes I have already seen the frame that the playhead is 
at the beginning of.  I have not.  Yes, when parked, that is the frame 
I see in the viewer.  But I have not yet seen that frame IN TIME.  I 
am about to see that frame.

In FCP, marking the out point at the playhead actually marks the end 
of the frame you are about to see.  It should mark the end of the 
frame you just saw.  It’s a small point, but frames add up!  I cut my 
teeth cutting actual film, way back when, so I still visualize editing in 
those terms.  

PS:  Is there a way when rubber-banding audio to change the 
adjustments from curved to linear?

Larry replies: Laurence, your comments about not seeing the out are interesting, 
but not true. In all cases, the Canvas shows the frame under the playhead. So, 
when you are watching a clip, you will always see every frame. When you mark 
an Out, you are marking the frame you are currently seeing, not the frame you 
are about to see.

Regarding rubber-bands, all video rubber bands are linear, and all audio bands 
are logarithmic. You can add bezier curves to any keyframe to change the shape 
anyway you like simply by control clicking on a keyframe. 

However, changing an audio fade to linear causes a drop in volume in the middle 
of the transition due to the fact that audio levels are not linear but logarithmic.

[ Go to top. ]

When to Use a TBC

Christopher Armstrong writes:

I have a question [regarding a Time-Base Corrector.] How do you 
sync the TBC to your computer. Are you using a capture card with a 
sync port, or a deck with FireWire.

I'm looking for a cheap solution to importing video into my G5. I'm 
mainly editing MiniDV or beta-cam sp and converting it at a 
duplicating house to MiniDV tapes.

Larry replies: DV gets brought in via FireWire and doesn't need sync; nor does it 
need a TBC.

All other formats need a capture card (i.e. Aurora, AJA, Blackmagic) which 
automatically provides sync. Betacam has its own TBC.

You'll only need a TBC, under most situations, for VHS.

A Word of Thanks

David Champe writes:

I've gotten your monthly newsletters for a few months now.  I realize 



I need to say "thanks" to you for this invaluable resource you've 
provided.  You've certainly helped me in some of the finer points of 
Final Cut Pro HD.  Thanks!

Larry replies: Thank you for the kind words. It may seem trite, but I really 
appreciate your taking the time to write. I publish this newsletter in the hopes 
that people find it useful. As long as I keep getting letters like yours, I'll continue.

Wrap-up

Well, that's it for this edition of the newsletter. Let me know what you think, and 
tell your friends to subscribe. I love reading your comments and sharing them 
with others. 

Or, send in some ideas of what you'd like us to talk about.

Even better, send in some tips of your own. I'm happy to publish everyone's 
ideas. That way, we all learn!

Thanks -- and have fun editing!

Larry

[ Go to top. ]

Subscribe to Larry's FREE Monthly 
Final Cut Pro HD Newsletter!

Email:    

 

Legal Notes

The newsletter is free -- but does require a subscription. Please invite your friends to 
sign up at www.larryjordan.biz.

To unsubscribe, simply send me an email and I'll drop you from the list. This list is not 
sold, rented, or bartered. The only person who knows you are on this list is me.

The information in this newsletter is believed to be accurate at the time of publication. 
However, due to the variety of possible system and software configurations, the author 
assumes no liability in case things go wrong. Please use your best judgment in applying 
these ideas.

The opinions expressed in these newsletters are solely those of the author. This 
newsletter has not been reviewed or sanctioned by Apple or any other third party. All 
trademarks are the property of their respective owners and are mentioned here for 
editorial purposes only.

Text copyright 2005 by Larry Jordan. All rights reserved. This newsletter may not be 
reproduced or published in any way, in whole or in part, without written (or emailed) 
permission from the author. 

Links to my website home page, or articles, are welcome and don't require prior 

http://www.larryjordan.biz/


permission. 
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